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ABSTRACT 
 
In this study, we briefly present the stages involved in the development of two types of didactic models, namely two 3D models of the 
relief of Cluj County, highlighting the main advantages and disadvantages offered by each of them, as well as several possibilities for their 
use in geography lessons. These 3D models are used in geography teaching for the formation of spatial representations of relief and 
running waters, for the localization of human settlements, and as tools for representing geographic space. 
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INTRODUCTION  
 
Maps represent the main teaching tools used in the teaching and learning of geography (Dulamă, 

2001, 2006). Maps are considered instruments employed for locating an element in space, for field 
orientation, route planning, spatial planning, etc. (Dulamă, 2006). The geographic map is defined as a “planar, 
conventional, reduced, and generalized representation of the Earth’s surface and of the natural or social 
phenomena occurring on it, produced for a specific purpose, according to mathematical rules” (Săndulache 
& Sficlea, 1970). Popa-Bota & Dulamă (1986) define the map as a “graphic representation of the Earth’s 
surface, conventional, generalized, reduced according to a scale and a cartographic projection, on which the 
spatial distribution of concrete or abstract elements that can be localized in space is depicted”. 

At the global level, a wide variety of maps is used to represent geographic aspects. In specialized 
literature, maps are classified according to several criteria: the position of the represented surface; the extent 
of the represented territory; content; scale; purpose; color scheme; method of use; place of publication; 
originality (Săndulache & Sficlea, 1970). 

In the teaching and learning of geography, various three-dimensional teaching aids are used, which 
represent in a simplified manner and at a small scale the essential features of complex objects, phenomena, or 
processes from reality (structure, components, shape, functionality, dynamics, etc.) (Dulamă & Roșcovan, 2007). 
Three-dimensional materials have three essential characteristics: fidelity (numerous analogies with the original), 
essentiality (defining specific characteristics), and reduction according to a scale (Dulamă & Roșcovan, 2007). 

Within the category of three-dimensional teaching aids are included didactic models (maquettes), 
which faithfully reproduce, according to a scale, the structure, components, shape, and functionality of a 
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real-world system (Dulamă & Roșcovan, 2007). Models can be constructed from various materials: paper, 
sheet metal, thread, wire, plastics (Dulamă & Roșcovan, 2007), polystyrene, LEGO pieces (Conțiu & Conțiu, 
2025). In the construction of models, a set of working techniques is used, such as cutting, gluing, assembly, 
painting, modeling, papier-mâché, origami, and quilling (Conțiu & Conțiu, 2025). 

“Three-dimensional maps” or “relief maps” can be included in the category of didactic models, as 
they are, in fact, 3D models. On these 3D models, students have the opportunity to easily observe the 
irregularities of the Earth’s crust (relief) and other details (running waters, proportionality of landforms, etc.). 

In this study, we briefly present the stages involved in the development of two types of didactic 
models, namely the two 3D models of the relief of Cluj County, the main advantages and disadvantages 
offered by each of them, as well as several possibilities for their use in geography lessons. We analyze two 
types of 3D maps: maps made of superimposed layers of plywood laser-cut according to selected contour 
lines, and maps produced from plastic material through 3D printing. In order to improve the educational 
process, two transparent maps printed at the same scale as the 3D maps (1:400,000) were also created: a 
map of the hydrographic network and a map of the boundaries of the Territorial Administrative Units (TAUs). 
These maps can be manually overlaid, similarly to layers in GIS software. 

 

MATERIALS AND METHODS 
 
Stages required for producing plywood didactic models: 
1. The administrative boundaries of Romania were downloaded from the ANCPI geoserver 

(https://geoportal.ancpi.ro/): level 1 (Romania’s national border), level 2 (Romania’s counties), and level 3 
(the boundaries of the Territorial Administrative Units – TAUs), as well as the “leveling data,” namely the 
archive of contour lines available at a five-meter equidistance. The spatial data are provided in the national 
projection system Stereo 70. In this study, only the data corresponding to Cluj County were used. 

2. From the available contour lines, eight layers considered relevant for Cluj County were selected: 
200 m, 300 m, 400 m, 500 m, 700 m, 1000 m, 1400 m, and 1600 m. 

3. The contours were adjusted (simplified) based on a subjective compromise between scientific/ 
geographical rigor and the need for generalization inherent in the production of small-scale cartographic 
materials (1:400,000), intended for didactic and/or illustrative purposes. The map scale was intentionally 
chosen to allow the integration of the model onto an A3-format board. Generalization was performed by the 
successive application of the “Simplify” and “Smooth” operations to each individual contour line, using ArcGIS 
Desktop 10.6.1 (ESRI, 2006; Imbroane, 2018). Any overlaps of contour lines resulting from the generalization 
process were manually corrected. For each elevation level, isolated (residual) polygons representing areas 
smaller than 100 ha were manually removed. 

4. Separate layout sheets were generated and exported in PDF format for each elevation level 
(Figures 1-8). On these sheets, the contour lines to be laser-cut were marked in black, while the contour lines 
corresponding to the next elevation level were marked in red, intended only for engraving. The pieces can 
be accurately positioned in their correct locations, similarly to a jigsaw puzzle. 

5. Using the files produced in the previous stage, each level was laser-cut and engraved from 4 mm 
thick plywood with the aid of a laser engraver (KL-9060 laser engraver). 

6. The pieces corresponding to each level were painted using acrylic watercolors. Colors as close as 
possible to conventional cartographic standards were chosen: the lowest-altitude surfaces were colored 
green; areas with medium altitudes (hills and plateaus) were painted in various shades of yellow; the highest-
altitude surfaces (mountain regions) were painted in shades of brown; and the highest peaks (Vlădeasa and 
Muntele Mare) were highlighted in purple. 

7. Finally, the painted pieces were placed in their correct positions and glued using a polyvinyl acetate 
(PVA)-based adhesive. 

In Figure 1, the base support (A3 format) and the contour lines corresponding to an altitude of 200 
m above sea level can be observed. The markings in black indicate the areas intended for cutting, while those 
in red indicate the areas intended for engraving. Figure 2 shows the layout of the second layer, which includes 
the contour lines corresponding to an altitude of 300 m above sea level, marked in black (for cutting), and 
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the contour lines corresponding to an altitude of 400 m above sea level, marked in red (for engraving). Figure 
3 presents the layout of the third layer, comprising the contour lines corresponding to an altitude of 400 m 
above sea level, marked in black (for cutting), and the contour lines corresponding to an altitude of 500 m 
above sea level, marked in red (for engraving). Figure 4 illustrates the layout of the fourth layer, which 
includes the contour lines corresponding to an altitude of 500 m above sea level, marked in black (for cutting), 
and the contour lines corresponding to an altitude of 700 m above sea level, marked in red (for engraving). 
In Figure 5, the layout of the fifth layer is shown, comprising the contour lines corresponding to an altitude 
of 700 m above sea level, marked in black (for cutting), and the contour lines corresponding to an altitude of 
1000 m above sea level, marked in red (for engraving). Figure 6 presents the layout of the sixth layer, 
including the contour lines corresponding to an altitude of 1000 m above sea level, marked in black (for 
cutting), and the contour lines corresponding to an altitude of 1400 m above sea level, marked in red (for 
engraving). Figure 7 shows the layout of the seventh layer, which includes the contour lines corresponding 
to an altitude of 1400 m above sea level, marked in black (for cutting), and the contour lines corresponding 
to an altitude of 1600 m above sea level, marked in red (for engraving). Figure 8 illustrates the layout of the 
eighth layer, which includes the contour lines corresponding to altitudes above 1600 m above sea level, 
marked in black (for cutting). It can be observed that only small land surface areas surrounding Vlădeasa Peak 
and Muntele Mare Peak remain at this level. 

Figure 9 shows the final appearance of the plywood model after cutting, painting, and assembly 
(detail of the western part of Cluj County). 

 
Figure 1  
Layout of the first layer 
 

 
 

Figure 2  
Layout of the second layer 
 

 

Figure 3  
Layout of the third layer 
 

 

Figure 4  
Layout of the fourth layer 
 

 
  



 

68 

Figure 5  
Layout of the fifth layer 
 

 

Figure 6  
Layout of the sixth layer 
 

 
Figure 7  
Layout of the seventh layer 
 

 
 

Figure 8  
Layout of the eighth layer 
 

 

Figure 9  
Detail of the plywood model showing the western part of Cluj County 
 

 
 

 Stages required for producing plastic didactic models using 3D printing: 
1. The digital elevation model (DEM) obtained through the Shuttle Radar Topography Mission (SRTM) 

project was downloaded from the OpenTopography platform (https://portal.opentopography.org/). The 
data are available in the World Geodetic System 1984 (WGS 84). 
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2. The administrative boundaries of Romania were downloaded from the ANCPI geoserver 
(https://geoportal.ancpi.ro/): level 1 (Romania’s national border), level 2 (Romania’s counties), and level 3 
(the boundaries of the Territorial Administrative Units – TAUs). For the purposes of this study, only the 
boundary of Cluj County was used, which was previously reprojected into the WGS 84 coordinate system 
(ArcMap → Data Management Tools → Projections and Transformations → Project). 

3. The digital elevation model was clipped to the outline of Cluj County in QGIS (Raster → Extraction 
→ Clip Raster by Mask Layer). 

4. An STL file was generated using the DEM 3D Printing plugin (Raster → DEMto3D → DEM 3D Printing), 
with the settings shown in Figure 10. A scale of 1:400,000 was selected, resulting in a model with dimensions 
of 297.95 mm in length and 184.17 mm in width. Given that the printer’s build plate measures only 220 × 220 
mm, the map was divided into two parts (one row, two columns). A vertical exaggeration of 3.5× was applied, 
resulting in a model height of 15.1 mm. A greater exaggeration would have produced an unsuitable, overly 
pointed appearance, particularly noticeable in hilly areas, while a smaller exaggeration would have resulted in 
a flatter, less expressive model. Considering that the lowest altitude within Cluj County is approximately 214 m, 
the base of the model was set at 200 m, a value close to the minimum altitude, so that the resulting model 
includes the full range of elevations, from the lowest to the highest within the county. The base thickness was 
set to 0.8 mm (with a filament thickness of 0.4 mm), allowing it to be printed in two filament layers. 

5. The two resulting files were subsequently processed using 3D Builder 20.0.4.0 (Microsoft 
Corporation) to insert the title and the numerical scale (”JUDEȚUL CLUJ, HARTA RELIEFULUI 3D” [3D Relief 
Map of Cluj County], ”1:400,000”). 

6. The map was printed using a 3D printer (Creality Ender-3 V3 SE) (Figures 11–12). 
 

Figure 10  
Settings used for generating the 3D (STL) file in QGIS with the DEM to 3D Printing plugin. 
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Figure 11  
View during the 3D printing of the “Relief Map of 
Cluj County” 

 

Figure 12  
Detail of the central area of the 3D relief map of Cluj 
County. The pencil tip indicates the location of Cluj-Napoca 

 
 

Stages required for producing transparent maps complementary to the 3D models: 
1. The administrative boundaries and the hydrographic network of Romania were downloaded from 

the ANCPI geoserver (https://geoportal.ancpi.ro/). Note: the spatial files available on the ANCPI geoserver are 
periodically updated; therefore, it is recommended to download and use the most recent available version. 

2. Using ArcGIS, thematic maps (TAU boundaries and hydrographic network) were generated at the 
same scale as the 3D model and exported as PDF documents (Figures 13–15). 

3. The PDF files were printed in color, A3 format, on transparent film. 
Depending on the specifics of the lesson, a wide range of other thematic maps can be prepared: 

types of land use, map of mountain peaks, map of the county's localities, climate maps, etc. 
 

Figure 13  
Map of the Territorial Administrative Units (TAUs) of 
Cluj County 

 

Figure 14  
Simplified map of the hydrographic network of Cluj 
County 

 
Figure 15  
Transparent map of the rivers of Cluj County overlaid on the 3D plywood map 

 



 

71 

In Table 1, the similarities and differences between the two types of 3D didactic models analyzed are 
presented. 
 
Table 1 
Comparative table between plywood three-dimensional models and maps printed using 3D printers (Cluj 
County at a scale of 1:400,000; A3 format)  
 

Comparison criteria 3D plywood map 3D-printed map 

Production cost 350 lei 500 lei 

Time required for GIS map preparation (vector PDF files / STL file) approx. 16 hours approx. 4 hours 

Execution time (laser cutting, painting, gluing / 3D printing) approx. 8 hours approx. 8 hours 

Water resistance no yes 

Resistance to handling (mechanical shocks) low (relatively) high 

Expressiveness (color) high low 

Realism / fidelity of landforms (relatively) low high 

Repairability (relatively) easy difficult 

Environmentally friendly (biodegradable) yes no 

Durability (resistance to decay) low high 

Suitability for didactic activities for persons with special needs (visually 
impaired) 

yes yes 

 

 

DISCUSSION AND CONCLUSIONS 
 
In works on the didactics of geography, the use of three-dimensional teaching aids, geographic 

globes, models, casts, and similar materials is recommended (Dulamă & Roșcovan, 2007). Teachers may use 
teaching materials produced by various companies, as well as teaching aids created using their own 
resources. In this study, we analyzed and presented the methodological approach followed to create such 
materials, using currently available technologies on the market. In order to develop such teaching aids, 
teachers need highly developed digital competences (the use of GIS, in this case), solid geographical 
competences (particularly in cartography and geomorphology), and, in order to use the created materials 
effectively, competences in the didactics of geography. 

Through the use of these teaching aids, students’ spatial representations are enhanced. In the fifth 
grade, the 3D models were used in the lesson addressing the main continental landforms (mountains, 
plateaus, hills, and plains). Students observed the irregularities representing landforms and established 
relationships between altitude and landform characteristics (appearance, slope, altitude), identified 
similarities and differences among landforms, analyzed the depth and density of relief fragmentation, and 
interpreted the colors used to represent elevation belts. The literature recommends that students compare 
landforms and, with the teacher’s guidance, explain the causes of relief irregularities, because if they observe 
these models on their own, they may not be motivated to understand why the Earth’s crust is uneven and 
how these irregularities were formed (Dulamă & Roșcovan, 2007). 

In the fifth grade, the 3D models were also used in lessons on running waters and on the local horizon 
(specifically for students from Cluj County) (Dulamă, 2010a). Students identified the location of river sources, 
observed the actual course of rivers, as well as tributaries and confluences along the main channels (for 
example, the Someșul Mic River with its tributaries Nadăș, Valea Caldă, Borșa, Lonea, Fizeș, etc.) (Figure 15). 
Studies indicate that pupils and students experience difficulties in establishing the relationship between relief 
and running waters and in locating peaks, ridges, and slopes (Dulamă & Ilovan, 2016). Through these 3D 
models, students learn to analyze and interpret aspects of real-world geography (Dulamă, 2010b). 

Students from various classes were challenged to indicate on the 3D map the locations of the 
municipalities of Cluj-Napoca, Gherla, and Dej. The 3D model does not display any toponyms; however, in 
order to solve the task, students were informed that each of the above-mentioned municipalities is located 
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approximately at the confluence of the Someșul Mic River with the following rivers: Nadăș, Fizeș, and 
Someșul Mare, respectively. Students were thus confronted with a problem that they attempted to solve. 
They first hypothesized the locations (with varying degrees of accuracy), then consulted the transparent map, 
overlaid it on the plywood map, and identified the locations of the three municipalities. A similar approach 
was applied to the localization of several Territorial Administrative Units (TAUs) on the map of Cluj County. 

Owing to their fidelity and durability, 3D models are well suited for research- and experimentation-
based activities conducted within geography clubs, aimed at explaining concepts such as valley dynamics, 
slope dynamics, and the suitability of areas for agricultural crops. Students can work in teams to produce 3D 
models using various methods, including the layer method (in which cardboard or expanded polystyrene is 
used instead of plywood) and the profile method (where a series of transverse topographic profiles of a given 
territory are cut from cardboard, equally spaced and then fixed onto a base at equal distances, according to 
the chosen scale) (Dulamă, 1996). The use of technology in new contexts is highly appreciated by students 
during geography lessons (Figure 16). 

We therefore recommend using either of the two 3D models for classroom use as didactic materials 
and geographic research activities, in combination with other visual materials (Magdaş, 2018). 

 
Figure 16  
Aspects from classroom use of the 3D plywood model in a fifth-grade class at “Avram Iancu” Secondary 
School, Dej 
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